SOC201/PSC 202/CJS 201

Lab #1

SOC 201/PSC 202/CJS 201
Lab #1: Excel Data Analysis(
Due at the beginning of lecture on _______________________.
Introduction
Now that you have been introduced to the basics of Excel, you can begin working on setting up a simple spreadsheet and performing some elementary analysis procedures. This assignment is not intended to demonstrate comprehensive statistical concepts. Rather, it will provide a hands-on introduction to the skills that will be needed in later assignments. 

This assignment uses the data provided by each of the SOC 201/PSC 202/CJS 201 students on the Student Background Questionnaire completed the first day of class.  In Part A, you will set up a worksheet, enter some data, load the student background data from an existing file, and finally save and print the results. In Part B, you will use Excel to do some calculations and sort the data in different ways.
PART A
Set up Table
· To begin, start Microsoft Excel. This will automatically create a new workbook with the title Book1. Once you have a clean spreadsheet, you can begin work on Exercise 1.  

· Leave the first four rows blank for now, so you will have room later to put your name and other important information on the top of the page before you hand in the assignment. Row 5 will consist of headers (i.e., variable names) indicating what data are in each column. The actual student background data will be added beginning with row 6. (Hint: When inserting values individually it is necessary for all the values of a particular variable to be in the same column, this is to ensure that the formulas which we frequently use work properly).
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· In row 5, enter the following headers (one column header each in columns A through X. 

Below, these headers are depicted in one column instead of one row for ease of reading.  (If you accidentally type these all in one column you can copy and paste special, transpose to place them in a row).

	A

	ID

	B

	NUMS


	C

	VARS


	D

	EQS


	E

	FORMS


	F

	MATHHIGH


	G

	MATHCOLL


	H

	COMFORT


	I

	EXPERIENCE


	J

	WINDOWS


	K

	WORD


	L

	EXCEL


	M

	SPSS


	N

	EMAIL


	O

	ON_LINE


	P

	UNDERSTAND


	Q

	APPLY


	R

	ASSESS


	S

	PROCESS


	T

	ANALYZE


	U

	OWN_PC


	V

	PC OR MAC

	W

	YEAR


	X

	SEX/GENDER



	


Hint:
After you type “ID” in cell A5, hit the tab key to move to cell B5 to enter “NUMS.”

Note:
The lines in “OWN_PC” and “ON_LINE” are underscores, not hyphens (as they would be in “own-pc”).

· You will notice that the ends of some labels are cut off (e.g.,“EXPERIENCE”), while other labels have blank space to the right of them because they are shorter and the text is left-justified. To save space (so more of the spreadsheet can fit on the screen), select the entire spreadsheet by clicking once on the small box in the upper left corner (to the left of A and above 1). Then select Format>Column>AutoFit Selection. [image: image2.jpg]‘See Edt vew
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· To unselect the sheet (i.e., get rid of the highlighting), click once anywhere in the worksheet.
Save File
Saving your work frequently is a good idea. In addition, you should ALWAYS maintain backups on a floppy disk.  Should anything go wrong, this will save you lots of time. You should get into the habit of saving your work whenever you complete a particular modification to the spreadsheet, or more often if you are making major modifications (e.g., entering lots of data).

· Excel is currently configured to use the “My documents” folder on your hard drive as the default location for opening or saving documents. Files saved on the hard drive are not secure and may be deleted or changed by anyone with access to that computer. Therefore, it is very important that you save all of your work in your folder on the H:drive and your A:drive (floppy disk) or Flash Drive.
Saving Your Work

· Under the File menu, select either Save or Save As.... (You can also use the toolbar Save button or the Ctrl-S keyboard shortcut to select the Save option.)  

· The default name Excel offers you is Book#, where # is usually 1, but could be another digit. To avoid confusion, save the file as Last Name Initials Exercise01 (i.e., SmithJM Exercise01. Make sure that the file is saved in your directory--on ‘commons’ (H:)”—on the LeMoyne H:drive file server.  It will be referred to as Exercise1 throughout the rest of this document.
After naming and saving the file, you can update it by simply using Save. However, if you wish to save a copy of the file under a new name, use the File/Save As... entry and repeat the process.

Copy data from external file in the Folder “Data for Labs and Final Paper”
In future assignments, you will sometimes be required to analyze a significant quantity of data. Rather than expect every student to enter all the data by hand, Excel data files will be provided that simplify your work.  In this case, there is a file called Lab 1 Spring 2007 Class Survey available on the server’s L:drive (at L:\CourseInformation\Stacey\Research Methods Fall 2008) (if L does not work try I) that contains the student background data. You must open that file and copy the data into your own file.

· First, select File/Open... or click on the Open button. This will launch the Open dialogue box. 

· Select the file L:\CourseInformation\Stacey\Research Methods Fall 2008\Lab 1 Spring 07 Class Survey and click on OK to open it. Your file will appear to be replaced by the new one, but don’t worry, it is still there. When you have more than one file open at a time, the Window menu can be used to switch between them. 

[image: image3.jpg]5 Microsoft Excel - Book1

9] Fle Edt Vew Insert Fomat Tooks Data | Window | Help AdobePDF

03[ & G| | Newwndow
A arrance.
zenf arar

4 B 53 Compare Side by Sice with 800k3

A 8 TETH]E T Hide

ame Uhide

Coursel/Saction

Excersize # it

Ereeze Panes

oo ro [ =

D NUMS VARS EQS FORMS

1800k3

o

09 0 0 0 0





· Under the Window menu is a numbered list of open files. Select Exercise1 and your file will reappear. 

· Switch back to Lab 1 Spring 07 Class Survey. Select all the data, but do not select the header row (Row 5 should be your header row).   Hint: You can also use Alt+Tab to switch between windows.
· Select Edit/Copy to copy the data. A flashing line will mark the outside of the range selected and copied.

· Switch to Exercise1. Click once on cell A6. Select Edit/Paste. The data will be copied into a range with cell A6 as the upper-most, left-hand corner. You do not need to select the precise range for pasting; it will be determined by the selection copied.  **Be sure that the data lines up appropriately with the titles.
Recall that after you entered the column headings, you automatically set the widths of columns so that they were no wider than necessary. Now that you’ve entered data in those “narrow” columns, some of the data may not fit. The ID column in particular is very narrow. Look down the column. You may notice # symbols in some of the cells. The # symbol indicates that the value in the cell overflows the border of the cell. You can reset the width of Column A by selecting it (or reset the widths of all columns in the spreadsheet as you did before by selecting the box in the upper left corner) and then selecting Format/Column/AutoFit Selection. 

· Because you want to be able to read the values in your spreadsheet, you should adjust the column width(s) now and verify that the data in every column and row can be read.

· It would be a good idea to save the file again at this time by selecting File/Save.

Set up Titles
For all SOC201/PSC 202/CJS 201 assignments, the top of the spreadsheet will consist of a title area that provides information on who you are and what assignment it is. 

· Enter the following in Column A: 

1. Enter your name in the first row (cell A1). 

2. In the second row (cell A2), indicate the course and your lab section as follows: SOC201/PSC 202/CJS-01 etc. 

3. In the third row (cell A3), indicate the assignment number as Exercise #n (in this case by substituting 1 for n).

4. Next you will print the spreadsheet (but read below first) by going to FILE/PRINT/ALL. However, first a few tips:
· First,go to the Page Setup dialog box and format the spreadsheet to print in landscape mode on 1 page. In the Page Setup dialog box, after formatting the orientation and scaling, click on the Sheet tab. In order to print the gridlines and letters and numbers that indicate the column and row headings, check the boxes for both “gridlines” and “row and column headings.” Then click on OK. 

· The next thing you will do is look at the print preview. This allows you to see what the worksheet will look like on the printed page without wasting paper if you decide there is a problem. Click on the Print Preview button and a small image of your spreadsheet will appear on the screen. To see an enlarged version, click on a spot on the page and it will expand. 

· Make sure the printer default is in this room and that you print in landscape mode. This is done by clicking on the Set Up button (you can also get there by File, Page Set Up).  Then select landscape.  Under the orientation section is a scaling section. Here you choose Fit to 1 page(s) wide by 1 tall. Click OK and print. Save this output (Printout #1), you are to hand it in with the rest of your assignment print-outs and analysis.

There are a few other things to note at this point:

1. Even though you just widened Column A somewhat to accommodate the ID codes, it is still very narrow. Nonetheless, your name seems to fit in the column (i.e., you don’t see # symbols when you type in your name). This is because the cells to the right of A1 are empty. If the cell to the right of a cell containing a datum is empty, then that datum can overflow into the adjoining cell. We will often take advantage of this feature when creating titles or multilevel column headers. 

2. If you had typed your name and Exercise 1 in Column A before you resized the column to accommodate the ID codes, then when you automatically resized the column width, Column A would have been made very wide so it could accommodate the longest text in the column (your name and Exercise #1). If you had needed to resize the column after typing a long string of text, you would have had to specify a precise column width rather than simply selecting the AutoFit option. 

3. The reason you left the first four rows blank earlier was to avoid this complication. The important point here is that a little insight into how Excel works can greatly simplify your life. 

4. Instead of leaving four rows blank, you could have entered column headers in the first row and then inserted blank rows above the column headers for your name, etc. To keep things simple for the first lab, we chose not to get into details about inserting rows or columns, but in the future you can do this.

5. Now that you know it is possible to insert blank rows above the first row in a spreadsheet, and you know how to open a file with a given name and save it under a different name, you realize you could have simply opened L:\CourseInformation\Stacey\Research Methods Fall 2008\Lab 1 Spring 07 Class Survey and saved it as Exercise1.XLS in your own directory on the LeMoyne H:drive file server, rather than copy the data from Lab 1 Spring 07 Class Survey.xls to Exercise1.XLS. In the future, this is what you will do, because copying and pasting large amounts of data is very inefficient and increases the likelihood of introducing errors.

PART B 

Creating an Analysis Subset
Often you will be interested in looking at only a few of the variables in your file. In this part of the assignment, you’ll first create a subset to allow you to look at students’ comfort levels with math and computers, and you will create some new variables to analyze. The first thing you want to do is subset the data set so that it only contains those variables that are essential for your analysis. 

Take a look at the Student Background Questionnaire. You will notice that each of the column headers you entered on your spreadsheet has been typed on the questionnaire adjacent to the specific questions they represent. (Not all the questions on the questionnaire have header names next to them. This is because some of the questions were important to the instructor but are not that valuable for this spreadsheet exercise.) 

Take a look at the variable NUMS, for example. NUMS is a shorthand representation of the question “How comfortable are you working with numbers?” What column headers represent are variable names. These variables have different values for each observation. In this case, the variable NUMS has five possible values ranging from 0 to 4, where 0 indicates that the respondent is not comfortable working with numbers and 4 indicates that the respondent is very comfortable working with numbers. 

· Highlight (by selecting the box to the left of A and above 1) and copy all the data on “Sheet 1.” Click on the “Sheet 2” file tab at the bottom left of your screen and paste the data into that worksheet. (select box A1 and paste) Now you should have two identical worksheets within your workbook. 

Excel allows you to rename each of your worksheets. To do this, you move your pointer over the worksheet’s file tab and double click the left mouse button. The existing name (e.g. “Sheet 1”) will become white with black highlights. You may then change the name of this worksheet by typing over the highlighted text. Press <Enter> to indicate that you have finished typing the new name.

· Rename Sheet 1 “All Data” and rename Sheet 2 “Selected Data.”

· Go to the Selected Data worksheet and delete the columns containing ON_LINE through SEX/GENDER. Select the columns to be deleted by clicking on the letter column heading (e.g., “O” for the ON_LINE column). You can select a contiguous set of columns by clicking on the letter column heading of the first column to be deleted and dragging your cursor to the letter column heading of the last column to be deleted. Select Edit/Delete to delete them. 

You should now have a worksheet “Selected Data” that is structured as follows:

	Name
	
	
	
	
	
	
	
	
	
	

	SOC/PSC 201-00x
	
	
	
	
	
	
	
	
	
	

	Exercise #
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	

	ID
	NUMS
	VARS
	EQS
	FORMS
	MATHHIGH
	MATHCOLL
	COMFORT
	EXPERIENCE
	WINDOWS
	WORD
	EXCEL
	SPSS
	EMAIL


Doing Calculations with Cell Addresses in Excel
The first thing you need to do is create columns in your worksheet for storing the results of your calculations. 

· To insert a column between FORMS and MATHHIGH, select the MATHHIGH column and chose Insert/Columns. Label the new column “MATHCOMF” (for mathematical comfort), and resize it to allow the text to fit into the cell without being cut off.  

The SUM function adds all the numbers in a specified range of cells. The COUNT function counts, in a specified range of cells, the number of cells that contain numbers. To add the numbers in cells J6, K6 and L6, for example, you would use the following formula: =SUM(J6:L6). In Excel, a colon in a formula is interpreted as meaning “through.” An alternate way of indicating a range of cells is by listing them individually. Thus, =SUM(J6:L6) is the same as =SUM(J6,K6,L6). To count the number of cells from J6 through L6 that contain numbers, you would use: =COUNT(J6:L6). See page 9 of this assignment for a key to mathematical operators in Excel. Note: Spaces will create errors in your formulas. Type all formulas without spaces. Also, always type = (an equal sign) at the beginning of a formula. If you use the Edit Formula  =   or Paste Function  fx  
buttons, Excel will insert an equal sign for you.

· In the first cell under the MATHCOMF header, write a formula using the SUM and COUNT functions (do not use the AVERAGE function
), and the cell addresses for the first student’s responses to the variables NUMS, VARS, EQS, and FORMS to calculate the average value of student #1’s responses to the four questions regarding mathematical comfort levels.  To do this, select the cell you wish to place the average in, type “=” and divide the sum by the count.  For example you may type in “=sum(B6:E6)/count(B6:E6).”  The letters and numbers will vary according to your spreadsheet.
· Once you have the result of the formula, click on the Decrease Decimal icon (looks like .00(.0) until your answer has only one decimal place.  (This may be hidden on your toolbar.)    

· Then copy the formula you’ve created to the remaining rows in that column by dragging the fill handle down the column, or by using Edit-Copy-Paste. To use the fill handle, select the cell you just typed the formula in and move your cursor to the bottom right corner of the selected cell. You’ll notice your white cursor becomes black—just hold down the left mouse button and drag the cursor down the column. At the last cell you want calculated, release the mouse button.  

· Check your results to make sure you’ve copied the formula correctly and are getting correct results. If you are, save your file and move on to the next step. If you’re not, figure out what you’ve done wrong before proceeding.

The next thing you want to calculate is the total number (SUM) of semesters of math courses each student has taken in high school and college. You could store the results of this calculation in the first empty column, but your spreadsheet is more intuitively comprehensible if you keep related variables together. 

· Create a column called MATHSEMS (for total number of semesters of math courses) to the right of MATHCOLL, resize the width if necessary (NOTE: Inserted columns are created to the left of a highlighted column, and inserted rows are created below a highlighted row). Calculate the total number of semesters for each student in this column. Note that the questions ask about semesters in college and years (2 semesters each) in high school.  Note, you do not need to use the sum or count functions, you can simply type in a formula such as “=G6*2+H6”
· Use the Increase Decimal button (.0 .00 to format the MATHSEMS values to 1 decimal place.  Save your work.

· Sometimes the Decrease Decimal icon does not work. If this happens, you can either try clicking first on the Increase Decimal icon, or you can use the Format option on the main menu. To format the number of decimal places in cells with the Format menu, use your cursor to highlight all of the cells you wish to format. Then choose Format/Cells…/Number and select the desired number of decimal places. Click OK. 

Next you are going to calculate the “average” level of experience that students have had with computers (their responses to the questions about their experience with Word, Excel, SPSS and e-mail). 

· Insert a column after EMAIL, and assign it the header EXPERAVG (for experience average). Resize the column width, if necessary.

· Use the AVERAGE function (such as =AVERAGE(M7:P7)) and the cell addresses for WORD, EXCEL, SPSS AND EMAIL to find the average value for each of the students. Round the values to one decimal point.  Then copy the formula you’ve created to the remaining rows in that column by dragging the fill handle down the column
· Check your results. If they are correct, save your file and continue. 

Doing Calculations with Ranges

You have already created three derived variables that, together with the original variables COMFORT and EXPERIENCE, allow you to summarize the mathematical and computing capacity of the class. The statistics you will use for such a summary are the minimum, the median, the mean, the standard deviation, and the maximum.  For each variable you will now calculate the minimum, median, mean, standard deviation and maximum. 
· In the cell in Column A that is two rows beneath the student data, you should type MINIMUM. In the cell beneath that, you should type MEDIAN. Beneath MEDIAN type MEAN, STD DEV, and MAXIMUM, so that each word is in a separate row in Column A. This placement allows readers to more easily interpret the spreadsheet because they will be able to compare values for different variables across the same row, as well as the values used in the calculations in each column. 

· In the row labeled MINIMUM, choose the appropriate Excel function using the Paste Function Button, (or INSERT, FUNCTION) and the named ranges you just created for these variables, to list the minimum values in the columns of the five variables of interest (COMFORT, EXPERIENCE, MATHCOMF, MATHSEMS, EXPERAVG). (You may also type the functions yourself, rather than using Paste Function.)  When typing your formula, type the correct range Minimum of some column as follows: =MIN(appropriate range)returns the minimum value.

· Do the same to find the median, mean, standard deviation of a population (use the formula titled stdev), and maximum for each of the five variables (List each of these values in the appropriate cell corresponding to the intersection of the variable (column) and the function (row). This is how all your future spreadsheets/assignments should look, with the calculations in the cell where the variable and function intersect. 

· Round to one decimal place and check your work. If everything looks okay, save your file and continue. 

· Hint: you will only produce minimum, median, mean, standard deviation and maximum for  COMFORT, EXPERIENCE, MATHCOMF, MATHSEMS, EXPERAVG.

More on Printing

The first thing you should do before you print a document is save it. Once you’ve saved your final document, you can print it out.

· Select File/Print... to open the print dialogue box. 

· If you look closely in print preview (FILE, PRINT PREVIEW), you will notice that some of the data are missing. This is because the entire sheet won’t fit on a single page and the columns on the right are printed on a different page. Click on the Next button to see the next page that contains the remaining columns of data.

This is not very useful, because is it difficult to compare the respondents’ answers to specific questions with their answers to other questions. Also, there is a lot of wasted space on the page as only the top half is used. To fit this entire worksheet on a single page, we need to print using landscape mode. This prints the worksheet along the long side of the paper, so more of it can all fit on a single page.

· To print the page in landscape mode, click on the Setup... button. 

· At the top of the Page Setup dialogue, it says Orientation. There are two options: Portrait and Landscape. The icons indicate how text appears in each orientation. Select Landscape and OK. 

· Now preview the page again. You see that much more fits on the page, but two columns may carry over onto another page. 

· Go back into setup by clicking on the Setup... button. Underneath the Orientation section of the Page Setup dialogue is a Scaling section. In the scaling section you can reduce or enlarge your spreadsheet for printing purposes. Click the Fit to: button and then specify that you want your spreadsheet to fit on 1 page(s) wide by 1 tall. 

You could have done this before and made the spreadsheet fit on the page in portrait mode, but then it would have been so scrunched up that you wouldn’t have been able to read the printout. You won’t always want to force a spreadsheet onto a single page, but because this one is small enough, it makes sense in this case to force it on one page in landscape mode. 

· Now the entire sheet is on a single page. Click on the Print... button to print the spreadsheet (Printout #2).
Sorting
It is sometimes useful to re-arrange the data in a table. Suppose you wanted to rank the students by mathematical comfort level or arrange the class list by experience with Excel. To do this, you can use the Data/Sort... capability of Excel. This allows you to re-arrange the rows according to some sort criteria. 

WARNING: always be careful when sorting data because you can seriously scramble your data. If you sort only part of a table, the relationship between cells can be lost. Also, if you have formulas that are dependent on the order of entries, they can produce errors. Always save a spreadsheet before trying to sort data. Also, check the results carefully and use Edit/Undo Sort to reverse the result if necessary.

· To sort the file by mathematical comfort level, select all of the respondent level data, not just for the MATHCOMF column, but for all of the variables in your selected data. (Yes, include the headers in the selection. Do not include the title section with your name, etc., or the statistics at the bottom.) 

· Then select the Data/Sort... menu item. At the bottom of the sort dialogue, you can specify whether your table has a header row; in this case it does. The header row will not be moved. At the top, select MATHCOMF from the Sort By list. There is also an option to sort Ascending or Descending. We want the lowest comfort levels at the top, so select Ascending. Click OK.  

· Check the table. The rows should have been re-arranged so that the students are ordered based on their math comfort level. 

· Preview and Print the spreadsheet (Printout #3). (If you have left and returned since your last printing job, make sure the printer is in landscape mode and you have fit the output on one page.) 

· Finally, repeat the sorting and printing to arrange the students in ascending order by their computing experience (EXPERAVG) (Printout #4). 

· Keep these two printouts. (You should now have 4 printouts).
· Save the file.
Printing Formulas
The final Excel task for this assignment is to print out the spreadsheet showing the formulas you have entered. 

· To do this, select Tools/Options.... Select the tab for View. One option for Window Options is Formulas. Select Formulas and click on OK. Your spreadsheet will now display the formulas rather than their values. 

· Always make sure all of the formulas can be read, as Excel does not automatically readjust the column widths to accommodate the length of the formulas. (If necessary, resize the columns by selecting your worksheet and clicking on Format/Columns/Autofit Selection).  

· Preview the worksheet to be sure it looks okay and print the formulas on 1 page in landscape mode (Printout #5). You should now have 5 printouts 

· As you already saved the file after your last sort, before you switched to formula view, exit Excel without saving changes.
· If you have time remaining in lab, you may want to begin writing your interpretation of the data. Remember to log off the computer before you leave.
Interpret the Results!
In this exercise, you employed several basic Excel skills. You entered data, copied and pasted data, inserted columns, wrote formulas to perform calculations, used intrinsic functions to perform calculations, performed calculations using cell addresses, performed calculations using variable names, sorted the file in different ways, and learned to control the printer. One final thing remains to be done. You must make clear that you understand what your findings mean by typing a brief description (less than 250 words, 12 point font, double spaced) of the population means for the three derived variables. You should state the variable names, what they represent, and what the mean scores indicate in terms of levels of comfort and experience with computers and math. For example, how comfortable are students with computers? 

Proof read and hand in your narrative, stapled along with your 5 printouts, no later than the beginning of class one week from today’s lab.
Assignment Checklist:


In order of appearance and neatly stapled)
 FORMCHECKBOX 

Title, Name, Section, & -+Date (no separate title page)

 FORMCHECKBOX 

Narrative

 FORMCHECKBOX 

Five printouts in order done
Calculation operators in formulas 
Operators specify the type of calculation that you want to perform on the elements of a formula.

***Remember the Order of operations: * and / occur before + and -, so place things in parentheses that should be completed together.  For example: use   =(A1+A2)/(A5+A4) instead of =A1+A2/A5+A4 or =(SUM(B7:E7))/(COUNT(B7:E7)) instead of =SUM(B7:E7)/COUNT(B7:E7). Arithmetic operators   To perform basic mathematical operations such as addition, subtraction, or multiplication; combine numbers; and produce numeric results, use the following arithmetic operators.

	Arithmetic
operator
	
Meaning
	
Example

	+ (plus sign)
	Addition
	3+3

	– (minus sign)
	Subtraction
Negation
	3–1
–1

	* (asterisk)
	Multiplication
	3*3

	/ (forward slash)
	Division
	3/3

	% (percent sign)
	Percent
	20%

	^ (caret)
	Exponentiation
	3^2 (the same as 3*3)


Reference operators   Combine ranges of cells for calculations with the following operators.

	Reference
operator
	
Meaning
	
Example

	: (colon)
	Range operator, which produces one reference to all the cells between two references, including the two references
	B5:B15

	, (comma)
	Union operator, which combines multiple references into one reference
	SUM(B5:B15,D5:D15)


Enter a formula

1. Click the cell in which you want to enter the formula.

2. Type = (an equal sign). Note: If you click the Edit Formula or Paste Function buttons, Excel inserts an equal sign for you. 

3. Enter the formula.

4. Press ENTER. 

Tips 

· You can enter the same formula into a range of cells by selecting the range first, typing the formula, and then pressing CTRL+ENTER.

· You can also enter a formula into a range of cells by copying a formula from another cell with the “fill handle” or copy+paste.
( Developed in conjunction with the Max 201 teaching team.


� If you do not know the name of a function you wish to use (calculate) select the box you wish to place the formula in and then select INSERT, FUNCTION (fx).  You can then type in the function you wish to insert such as average, mean, median etc. and the function wizard will provide options to choose from.  You then select the appropriate option and the wizard will either let you select the appropriate boxes to include in your formula, or you can cancel and type it in yourself.


� Hint: see page 11, Calculation operators in formulas.
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